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1. Getting started

Getting started provides a cursory view of data acquisition and walks you through a procedure to
set up a simple system. You may not find it necessary to progress beyond this. However, should
you want to dig deeper into the complexity of the data logger functions or quickly look for
details, extensive information is available in the full GRANITE 6 manual.

This exercise guides you through the following steps:

» Connecting the data logger to a computer

 Attaching a sensor to the data logger

 Creating a program for the data logger to measure the sensor
» Making a simple measurement

» Storing measurement data on the data logger

 Collecting data from the data logger with a computer
 Viewing real-time and historical data with a computer

In addition to your data logger, the following items are used in this exercise (many are shipped
with your data logger and all are available on www.campbellsci.com E7II):

» Type T thermocouple, 4 to 5 inches long; one is shipped with the data logger

o Computer with a USB port

e USBcable

» Data logger support software such as LoggerNet, RTDAQ, or PC400 installed on your
computer

Additional Campbell Scientific publications are available online at www.campbellsci.com 1.
Video tutorials are available at www.campbellsci.com/videos > Generally, if a particular feature
of the data logger requires a peripheral hardware device, more information is available in the
manual written for that device.

1. Getting started
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2. USB communications

Setting up a USB connection is a good way to begin communicating with your data logger.
Because this connection does not require configuration (like an IP address), you need only set up
the communications between your computer and the data logger. Use the following instructions

or watch the Quickstart videos at https://www.campbellsci.com/videos >

TIP:
‘ You will physically connect your data logger to your computer in step 6.

Follow these steps to get started. These settings can be revisited using the data logger support
software Edit Datalogger Setup option =,

1. Using data logger support software, launch the EZSetup Wizard.

NOTE:
New software installations automatically open the EZSetup Wizard the first time they
run.

* LoggerNet users, click Setupm, select the View menu and ensure you are in the EZ
(Simplified) view, then click Add Datalogger'li;.

* RTDAQ users, click Add Datalogger%.
* PC400 users, click Add Datalogger-'i;.
2. Click Next.

3. Select your data logger from the list. In the Datalogger Name field, type a meaningful
name for your data logger (for example, a site identifier or project name), and click Next.

4. Select the Direct Connect connection type and click Next.

5. If this is the first time connecting this computer to a GRANITE 6 via USB, click Install
USB Driver, select your data logger, click Install, and follow the prompts to install the
USB driver.

6. Plug the data logger into your computer using a USB cable. The USB connection supplies
5V power as well as a communications link, which is adequate for setup. A 12 V battery will
be needed for field deployment. If using RS-232, external power must be provided to the
data logger, and a CPI/RS-232 RJ45 to DB9 cable is required to connect to the computer.

2. USB communications 2
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NOTE:

The Power LED on the data logger indicates the program and power states. Because
the data logger ships with a program set to run on power-up, the Power LED flashes
three times every 10 seconds when powered over USB. When powered with a 12 V
battery, it flashes once every 10 seconds. When no program is running, the LED is
always on.

From the COM Port list, select the COM port used for your data logger. It will appear as
GRANITE 6 (COM number).

USB connections do not typically require a COM Port Communication Delay; this type of
delay allows time for hardware devices to "wake up" and negotiate a communications link.
Accept the default value of 00 seconds and click Next.

You must match the PakBus address hardware settings of your data logger. A USB
connection does not require a baud rate selection, keep the default. The default PakBus
addressis 1.

Set an Extra Response Time if you have a difficult or marginal connection and you want the
data logger support software to wait a certain amount of time before returning a
communications failure error. Accept the default value of 00 seconds.

Set a Max Time On-Line to limit the amount of time the data logger remains connected.
When the data logger is connected, communications with it are terminated when this time
limit is exceeded. A value of 0 in this field indicates that there is no time limit for
maintaining a connection to the data logger.

Leave the Neighbor PakBus Address as the default of 0.
Click Next.

By default, the data logger does not use a security code. Therefore, the Security Code can
be left at 0. If the code has been changed in the data logger, enter the new code.

The PakBus Encryption Key can be left blank for direct USB connections.
Click Next.

Review the Setup Summary. If you need to make changes, click Previous to return to a
previous window and change the settings.

Setup is now complete. The EZSetup Wizard allows you to Finish, or you may click Next to
test communications, set the data logger clock, and send a program to the data logger. See
Testing communications with EZSetup (p. 4) for more information.

2. USB communications
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3. Testing communications with
EZSetup

1. Advance to, or select, the Communication Test step in EZ Setup. See USB communications
(p. 2) for more information.

Progress Communication Test

Introduction You now have the option of testing communication with the datalogger.

This will ensure that the datalogger has been set up correctly. The
connection will be kept online so that other setup tasks can be
performed (i.e, check/set clock, program send).

Communication Setup
Datalogger Settings

Setup Summary

Test Communication?

(®) Yes
Datalogger Clock () Ne

% Communication Test

Send Program

2. Ensure the data logger is physically connected to the computer, select Yes to test
communications, then click Next to initiate the test.

3. With a successful connection, the Connection Time with the data logger is displayed in the
lower-left corner of the wizard. Click Next.

4. The Datalogger Clock window displays the time for both the data logger and the computer
(server).

» The Adjusted Server Date/Time displays the current reading of the clock for the
computer running your data logger support software. If the Datalogger Date/Time
and Adjusted Server Date/Time do not match, click Set Datalogger Clock to set the
data logger clock to the computer clock.

« Optionally, specify a positive or negative Time Zone Offset to apply when setting the
data logger clock. This offset allows you to set the clock for a data logger thatisin a
different time zone than the computer (or to accommodate for changes in daylight
saving time).

5. Click Next.

3. Testing communications with EZSetup 4



6. The data logger ships with a default GettingStarted program. If the data logger does not
have a program, you can choose to send one by clicking Select and Send Program. Click
Next.

7. LoggerNet only - Use the following instructions or watch the Scheduled/Automatic Data
Collection video &

» The Datalogger Table Output Files window displays the data tables available to be
collected from the data logger and the output file name. By default, all data tables set
up in the data logger program will be included for collection. Make note of the
Output File Name and location. Click Next.

» Check Scheduled Collection Enabled to have LoggerNet automatically collect data
from the data logger on the Collection Interval entered. When the Base Date and
Time are in the past, scheduled collection will begin immediately after finishing the
EZSetup wizard. Do not set up a scheduled collection during this tutorial. Click Next.

8. Click Finish, or you may click Next to test communications, set the data logger clock, and
send a program to the data logger.

3. Testing communications with EZSetup 5
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4. Making the software
connection

Once you have configured your hardware connection (see USB communications [p. 2]), your data
logger and computer can communicate. Use the Connect screen to send a program, set the
clock, view real-time data, and manually collect data.

LoggerNet users, select the Main category and Connect B on the LoggerNet toolbar, then select
the data logger from the Stations list, then click Connect ¥a. Once connected, select a table to
view in the Table Monitor.

Stations Table Monitor: Real Time Moenitoring

BN StationOne Public w Show Units
DataTablelnfo

Status

Test 25 PM
PTemp 2682343
batt_wvolt 0

RTDAQ and PC400 users, click Connect ¥4, then Monitor Data. When this tab is first opened for a
data logger, values from the Public table are displayed. To view data from other tables, click Add
), select a table or field from the list, then drag it into a cell on the Monitor Data tab.

Additionally, RTDAQ has a Start/Stop button to start and stop monitoring data values. The name
of this button changes based on its state.

4. Making the software connection

6



WE>= DD BEGEH

Clock/Prograrn  Moniter Data  Collect Data

| = o |
Add Delete  Pd Add Selection
=
RecNum Tables Fields
TimeStamp | | DataTablelnfo RecMurn
1 | FifteenMin TirneStamp
Flemp % | Hourl Logger
batt_volt Onebin_—————I6¥
1 | Public batt_volt_Min
109 C | |RefTable PTemp
Status T109_C
Diff2
A Diff2_Avg
Diff2_5td
1 SE3
SE3 Awvg

For more information, see Working with data (p. 17).

NOTE:
When powered only by USB, the battery voltage is reported as 0.00. This is to remind you that
a 12 V battery is needed for field deployment.

See Collecting data (p. 18) for more information on copying stored data from the data logger to
the computer.
To disconnect, click Disconnect .

For more information, see the Connect Window Tutorial I:

5. Measurement quickstart
using SURVEYOR

Campbell Scientific SURVEYOR software is an easy way to quickly see measurement results and
store data from a GRANITE Measurement Module. The module configuration can be saved on
the computer or exported as a CRBasic data logger program. SURVEYOR is available as a
download from www.campbelIsci.com/cs—surveyor|:7II. A video tutorial is available at
www.campbellsci.com/videos/surveyoru.

5. Measurement quickstart using SURVEYOR 7
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If your data acquisition system does not include a GRANITE Measurement Module such as the
VOLT 100 series proceed to Programming quickstart using Short Cut (p. 11).

This section will guide you through reading a differential Type-T thermocouple on a VOLT 100
series Measurement Module. With minor changes, these steps can apply to other compatible
measurements and Measurement Modules.

1.
2.

Open SURVEYOR @™,
Connect a USB cable between your computer and the VOLT 100 series USB port.

Apply 9.6 to 32 VDC external power using the green Power connector on the side of the
VOLT 100 series.

Select Connect Now.

5. Select the communications port, it will be labeled similar to VOLT 100 series (COM3).

Make selections for Speed or Noise Rejection and CAN enabled. See the SURVEYOR help
@ for more information on all settings.

Click Apply.

Select a Sample Rate. For this exercise, select 10 Hz. (1/2 Hz is typical for thermocouple
measurements.)

Add Measurement(s). For this exercise, add a Type-T differential thermocouple on DIFF1.

VOLT 108 X0

SAMPLE RATE: 10 HZ

= ADD MEASUREMENT

Supply Voltage»

[ App caLcuLaTiON Panel Thermistorp

. Single Ended Voltage »

Differential Voltage »

I Differential Thermocouple b I DIFF1

Half-Bridge » DIFF2
Full-Bridge » DIFF3
DIFF4

Strain Quarter Bridge »
DIFF5

DIFF6
Campbell Thermistor Probe » = DIFF7

Resistance Measurement »

Period or Frequency of Signal|  DIFF8

5. Measurement quickstart using SURVEYOR



10. Wire the sensor according to the given wiring diagram.

Wire Color
Sig+ Blue
Sig Red

Variable Name @

tediff1

Thermocouple Type @

TypeT Copper Constantan =

Units 0

C -

11. Complete the rest of the form and Apply to save the configuration.

5. Measurement quickstart using SURVEYOR 9



12. Check the resulting measurements in the numeric and graphic displays.

VOLT 108D @

> 231224
SAMPLE RATE: 10 HZ S0

= ADD MEASUREMENT 23116 ‘

I App caLcuLATION 23110 ;‘l ‘\ |\

15:1450 15:14:50500 15:1451 151451500 15:1452 15:14:52500 15:14:53 15:14:53500 15:14:54 15:1454500 15:14:5

9

13. Click Start Storing Data CEEEERA While data is being stored the options to stop and
pause data storage become available.

6. Programming quickstart
using SURVEYOR

Campbell Scientific SURVEYOR is an easy way to generate a simple CRBasic program for your
VOLT 100 series Campbell Scientific data acquisition system.

1. Configure the VOLT 100 series for measurements, see Measurement quickstart using
SURVEYOR (p. 7).

6. Programming quickstart using SURVEYOR
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2. Select File > Export Datalogger Program then select the data logger you will be connecting
the VOLT 100 series to. For this example, we'll select GRANITE 6.

Camphbell Scientific Surveyor Version 1.00
File Opticns Help

Import Configuration

Export Configuration

Export Datalogger Program  # CR&

Reset Device

Exit GRANITE 10

3. By default, the CRBasic program will be saved in
C:\Users\username\Documents\SURVEYOR.

/. Programming quickstart

using Short Cut

Short Cut is another easy way to program a Campbell Scientific data acquisition system to
measure a sensor and assign wiring terminals. Short Cut is available as a download from
www.campbellsci.com/shortcut . Itis also included in installations of LoggerNet, RTDAQ, and

PC400.

The following procedure shows using Short Cut to program the data logger to measure a type-T

thermocouple on a VOLT 100 series.

1. Open Short Cut and click Create New Program.
2. Double-click your data logger.

3. Inthe Available Sensors and Devices box, start typing GRANITE. You can also locate it in the
Devices folder. Double click the GRANITE Measurement Module you are working with.
Type the serial number located on the VOLT 100 series label. Optionally, type a name in the
Module ID String if you want the module to have an ID. This is useful when multiple VOLT

100 series modules are connected to the data logger.

7. Programming quickstart using Short Cut 11
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File Program Tools

Progress
1. New/Open
. Datalogger

2
3. Sensors
4

. Output Setup

~ o

. Finish

wiring
Wiring Diagram

Wiring Text

. Output Select

Help Test

Available Sensors and Devices

C—

| GRANITE

v [ Devices

~|] GRANITE TEMP 120
-] GRANITE VOLT 108
-] GRANITE VOLT 116

Selected Measurements Available for

Exact Match .Output
Sensor | Measurement
4 GRANITE
4-Default BattVv
| PTemp_C
I
() GRANITE VOLT 108 Module (Version: 1.0} m] *

Serial Number’

Module ID String

P ]
[

GRANITE

©

Select the sensorg
view the sensors i
expansion arrow
filter results based
Selected Measurer

GRANITE VOLT 108 Module

Enter the serial number of the module (found on a

label}.

Optionally enter a name (Module ID) which can be
used to identify the module.

The GRANITE VOLT 108 Module adds & differential
measurement channels.

box and selecting one of the other options.

File Program Tools

Progress
1. New/Open
2. Datalogger
3. Sensors

4. Output Setup

6. Output Select
7. Finish

Wiring
Wiring Diagram
Wiring Text

Help Test

Available Sensors and Devices

type t X Exact Match

| GRANITE VOLT 108
v {7 Sensors

~ | Temperature
--_] Type T Thermocouple

Selected s Available for
OQutput
| Sensor Measurement
| 4 GRANTTE
4 Default Battv
PTemp_C

&) Type T Thermocouple (Version: 2.0)

Properties wiring

]

4. In the Available Sensors and Devices box, type Type T. You can also locate the
thermocouple in the Sensors > Temperature folder. Double click Type T Thermocouple.
Type the number of type T thermocouples connected to the VOLT 100 series. The
temperature defaults to degree C. This can be changed by clicking the Temperature units

| eranmeEvolT8 ||
R RrRr”r”™—Y,,,esss \

x

How many Type T TC sensors? (Max=8) |1 -

Filtering Option Filter 50/60 Hz Noise

-DegC e

| Type T Thermocouple

54 Units for Temperature: Deg C, Deg F, K
‘ /

Cancel

Help

7. Programming quickstart using Short Cut
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5. Click on the Wiring tab to see how the sensor is to be wired to the VOLT 100 series. Click OK
after wiring the thermocouple.

(& Type T Thermocouple (Version: 2.0) O x

Propertied Wiring

Type TTC GRANITE VOLT 1038
Blue 1H
Red iL

Click a GRANITE VOLT 108 terminal name to change a wire's location.

Type T 'I;Hermocoupie
Units for Temperature: Deg C, Deg F, K

\'+

Cancel Help

6. Repeat steps four and five for other sensors you want to measure. Click Next.

7. In Output Setup, type the scan rate, a meaningful table name, and the Data Output Storage
Interval.

File Program Iools Help Test

Progress
: i ?
1. New/Open How often should the GRANITE © measure its sensor(s)? Seconds - @
2. Datalogger
3. Sensors
4. Output Setup Data is proct_essed by the datalogger and
then stored in an output table. Two tables © Add New Table )
5 are defined by default; up to 10 tables can
6. Output Select e
7. Finish "
1 FiveSec |2 Table2 |
Table Name &l
Wiring FiveSec @ Delete Table @
Wiring Diagram
Wiring Text Data Output Storage Interval

Makes 12 measurements per output
interval based upon the cheosen 5 = Seconds o @
measurement interval of 5 Seconds.

v
[] Advanced Outputs (all tables) @
multiple output intervals can be specified, one for each output table. By default, an output table is set up to

send data to memory based on time. Select the Advanced Output option to send data to memory based on
one or more of the following conditions: time, the state of a flag, or the value of a measurement.

. Specify how often measurements are to be made and how often outputs are to be stored. Note that

4 Previous Next Finish Help

7. Programming quickstart using Short Cut
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8. Select the measurement and its associated output option.

Wiring Text

File Program Tools Help Test
Progress Selected Measurements Available Selected Measurements for Output
for Output
1. New/Open
Sensor Measurement Average 1 FiveSec |2 Table2
2. Datalogger ~
3. Sensors b (?RANITE ETo Sensor  easuremer rocessing utput Lab: Units
! PTemp_C —
5 : Minimum
- 4 GRANITE
6. Output Select
7. Finish StdDev
Total
Wiring
Windvector
Wiring Diagram

#  Edit » Remove

Select which measurements to store in which tables and how each measurement should be
processed. For each value to be stored in the table, choose a measurement from “Selected
Measurements Available for Output.” Next, select one of the processing functions, such as
Average, Sample, etc. Mote that the output tables must be set up in order for data to be stored
in the datalogger memory.

4 Previous Finish

Next Help

9. Click Finish and save the program. Send the program just created to the data logger if it is

connected to the computer.

10. If the thermocouple

is connected to the VOLT 100 series, check the output of the

thermocouple in the data display of LoggerNet, RTDAQ, or PC400 to make sure it is making
reasonable measurements.

7. Programming quickstart using Short Cut

14



8. Sending a program to the
data logger

TIP:
It is good practice to always retrieve data from the data logger before sending a program;
otherwise, data may be lost. See Collecting data (p. 18) for detailed instruction.

Some methods of sending a program give the option to retain data when possible. Regardless of
the program upload tool used, data will be erased when a new program is sent if any change
occurs to one or more data table structures in the following list:

 Data table name(s) » Number of bytes per field
« Data output interval or offset  Field type, size, name, or position
e Number of fields per record e Number of records in table

Use the following instructions or watch the Quickstart part 3 video >

1. Connect the data logger to your computer.

* LoggerNet users, select Main and Connect B on the LoggerNet toolbar, select the
data logger from the Stations list, then Connect e,

* RTDAQ and PC400 users, select the data logger from the list and click Connect e,

2. LoggerNet users, click Send New... (located in the Current Program section on the right side
of the window).

RTDAQ and PC400 users, click Send Program... (located in the Datalogger Program section
on the right side of the window).

3. RTDAQ and PC400 users, confirm that you would like to proceed and erase all data tables
saved on the data logger. Click Yes.

4. Navigate to the program, select it, and click Open. For example: navigate to
C\Campbellsc\SCWin and select MyTemperature.CRB. Click Open.

5. LoggerNet users, confirm that you would like to proceed and erase all data tables saved on
the data logger. Click Yes.

6. The program is sent and compiled.

7. Review the Compile Results window for errors, messages and warnings.

8. Sending a program to the data logger 15
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8. LoggerNet users, click Details, select the Table Fill Times tab.
RTDAQ and PC400 user click OK then click Station Status , select the Table Fill Times tab.

Ensure that the times shown are expected for your application. Click OK.

% L] Table Fill Times
Table Information
Table Name # of Records Table Fill Time
FifteenMin 31575 328 days 21 hours 43 mins 0.0 secs
Hourly 2040 335 days 0 hours 0 mins 0.0 secs
OneMin 471760 327 days 14 hours 40 mins 0.293 secs
RefTable 47585 330 days 10 hours 49 mins 59,707 se...

After sending a program, it is a good idea to monitor the Public table to make sure sensors are
taking good measurements. See Working with data (p. 17) for more information.

8. Sending a program to the data logger 16



9. Working with data

9.1 Default data tables

By default, the data logger includes three tables: Public, Status, and DataTablelnfo. Each of these
tables only contains the most recent measurements and information.

 The Public table is configured by the data logger program, and updated at the scan interval
set within the data logger program. It shows measurement and calculation results as they
are made.

» The Status table includes information about the health of the data logger and is updated
only when viewed.

» The DataTablelnfo table reports statistics related to data tables. It also only updates when
viewed.

» User-defined data tables update at the schedule set within the program.

For information on collecting your data, see Collecting data (p. 18).
Use these instructions or follow the Connect Window tutorial & to monitor real-time data.

LoggerNet users, select the Main category and Connect B on the LoggerNet toolbar, then select
the data logger from the Stations list, then click Connect ¥a. Once connected, select a table to
view in the Table Monitor.

Stations Table Monitor: Real Time Moenitoring
BN StationOne Public w Show Units
DataTablelnfo
Status
Test 25 PM
PTemp 26.82343
batt_wvolt 0

RTDAQ and PC400 users, click Connect ¥4, then Monitor Data. When this tab is first opened for a
data logger, values from the Public table are displayed. To view data from other tables, click Add
), select a table or field from the list, then drag it into a cell on the Monitor Data tab.

Additionally, RTDAQ has a Start/Stop button to start and stop monitoring data values. The name
of this button changes based on its state.

9. Working with data 17
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Clock/Prograrn  Moniter Data  Collect Data
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Add Delete  Pd Add Selection
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TimeStamp | | DataTablelnfo RecMurn
i - | FifteenMin TirneStamp
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Status T109_C
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Diff2_5td
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9.2 Collecting data

The data logger writes to data tables based on intervals and conditions set in the CRBasic
program. After the program has been running for enough time to generate data records, data
may be collected by using data logger support software. During data collection, data is copied to
the computer and still remains on the data logger. Collections may be done manually, or
automatically through scheduled collections set in LoggerNet Setup. Use these instruction or

follow the Collect Data Tutorial I:

9.2.1 Collecting data using LoggerNet

1. From the LoggerNet toolbar, click Main and Connect B2 select the data logger from the
Stations list, then Connect %.

2. Click Collect Now .

3. After the data is collected, the Data Collection Results window displays the tables collected
and where they are stored on the computer.

4. Select a data file, then View File to view the data. See Viewing historic data (p. 19).

9.2.2 Collecting data using RTDAQ

1. Click Connect % on the main RTDAQ window.

2. Go to the Collect Data tab.

9. Working with data
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3. Leave the default Collection Options:
* Collect Mode should be Data Since Last Collection
+ File Mode should be Append to End of File.
 File Format should be ASCII Table Data (TOA5)

4. Select the check boxes for tables in the Table Collection list to indicate which tables will be
collected.

5. Click Start Collection.

6. After the data is collected, the Data Collection Results window displays the tables collected
and where they are stored on the computer.

7. Select a data file, then View File to view the data. See Viewing historic data (p. 19).

9.2.3 Collecting data using PC400

1. Click Connect % on the main PC400 window.
2. Go to the Collect Data tab.

3. By default, all output tables set up in the data logger program are selected for collection.
Typically, the default tables (DataTablelnfo, Public, and Status) are not collected.

4. Select an option for What to Collect. Either option creates a new file if one does not already
exist.

» New data from data logger (Append to data files): This is the default, and most often
used option. Collect only the data, in the selected tables, stored since the last data
collection from this instance of PC400 and append this data to the end of the existing
files on the computer.

+ All data from data logger (Overwrite data files): Collects all of the data in the selected
tables and overwrites (or replaces) the existing data files on the computer.

5. Click Start Data Collection.

6. After the data is collected, the Data Collection Results window displays the tables collected
and where they are stored on the computer.

7. Select a data file, then View File to view the data. See Viewing historic data (p. 19).

9.3 Viewing historic data

View Pro B contains tools for reviewing data in tabular form as well as several graphical layouts
for visualization. Use these instructions or follow the View Data Tutorial 4.

9. Working with data 19
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Once the data logger has had enough time to store multiple records collect and review the data.

1. To view the most recent data, connect the data logger to your computer and collect your
data (see Collecting data (p. 18) for more information).

2. Open View Pro:
* LoggerNet users click Data then View Pro B on the LoggerNet toolbar.
* RTDAQ and PC400 users click View Data Files via View Pro 2]

3. Click Open 1‘"", navigate to the directory where you saved your tables (the default directory
is C:\Campbellsci\[your data logger software application]). For example: navigate to the
C:\Campbellsci\LoggerNet folder and select OneMin.dat.

4. Click Open.

9. Working with data
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